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El número de serie está situado en el panel posterior de la unidad. Se recomienda anotar el número 
de serie en el espacio provisto para ello. Mencione este número cada vez que contacte con el 
fabricante o con un técnico autorizado de Apogee Electronics. ¡No olvide devolver la garantía tras 
rellenar todos los datos!

Nº serie Ensemble___________________________________________________

Fecha de compra__________________________________________________________
 
Vendedor_________________________________________________________________

Teléfono_________________________________________________________________

Dirección________________________________________________________________

ATENCIÓN:
En cumplimiento con lo dispuesto por la legislación FCC, cualquier cambio o modificación sin 
aprobación expresa de APOGEE ELECTRONICS CORPORATION podría anular su derecho a 
utilizar este equipo 

Registre su unidad rellenando el formulario incluido o a través de la web visitando
http://www.apogeedigital.com/support/register.php Por favor, lea este manual en su totalidad 
– si contacta con el servicio de asistencia técnica daremos por hecho que lo ha leído. El usuario 
deberá responder a un cuestionario.

Registro del propietario
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Introducción

Ensemble es una interfaz de audio Firewire controlada digitalmente y diseñada específicamente para 
ordenadores Apple Macintosh. Ensemble incluye todo lo necesario para un sistema de grabación de 
calidad superior basado en Mac: desde preamplificadores de micrófono hasta la conectividad Mac Core 
Audio, pasando por las salidas de auriculares.

La interfaz Ensemble incorpora varias de las tecnologías Core de Apogee; por ejemplo:

SoftLimit 

Soft Limit es un circuito de limitación analógico capaz de controlar instantánea y elegantemente los picos 
transitorios, ofreciendo 4 dB adicionales de headroom. Soft Limit puede ser activado en cualquiera de las 
8 entradas analógicas de Ensemble.

UV22HR 

UV22HR es el algoritmo de dither estándar de Apogee para la reducción de la resolución de una señal de 
audio digital de 24 a 16 bits. UV22HR también se utiliza para mejorar el contenido de audio en Internet y 
ordenadores sin que por ello aumente el tamaño de los archivos o la velocidad de los datos. 

Sample Rate Conversion (SRC) de Apogee

La conversión de la frecuencia de muestreo de Ensemble proporciona una solución flexible y de gran 
calidad para trabajar con distintas frecuencias de muestreo en unidades hardware/software de audio 
digital. La conversión de la frecuencia de muestreo de Ensemble puede aplicarse a una entrada digital 
(para convertir la señal entrante en la frecuencia de muestreo de la unidad) o a una salida digital (para 
convertir la señal de salida en una frecuencia de muestreo distinta de la de Ensemble seleccionada por 
el usuario).

Requisitos de Ensemble

1. Apple PowerMac 1,5 GHz o superior, 512 MB de RAM, 1 GB (recomendado)
2. OS X 10.4.11 o 10.5 y superior; OS X 10.5.3 o superior (altamente recomendado)
3. Apple Logic Pro 7.2.3 o 8.0 y superior
4. Un cable Firewire 400

Importante:
El funcionamiento descrito en este manual está basado en la versión 1.3 del firmware y software 
de Ensemble, comercializados en febrero de 2007.



APOGEE ELECTRONICS

4

Ensemble – Manual del usuario

Guía de inicio rápido

1. Instalación del software
 Introduzca el CD suministrado en la unidad 

óptica de su Mac, pulse dos veces sobre el icono 
del Ensemble Software Installer y siga las 
instrucciones que aparecen en la pantalla. Una 
vez finalizada la instalación, reinicie el sistema.

2. Conexiones del hardware
 Conecte uno de los puertos FireWire de Ensemble 

a un puerto FireWire 400 del Mac usando el cable 
FireWire suministrado (figura 2).

 

 

 Conecte la entrada de alimentación de Ensemble 
a una toma de corriente de 90-250 voltios; el 
interruptor de alimentación de la unidad se 
iluminará para indicar la presencia de corriente. 
Pulse el interruptor de alimentación para poner la 
unidad en funcionamiento (figura 3).

 Conecte un par de auriculares a la salida  1 de 
Ensemble (figura 4). 

figura 1

figura 2

figura 3

figura 4
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3. Configuración OS X
 En la barra de menú Apple de su Mac, abra 

la ventana Preferencias del sistema y pulse 
sobre el icono de sonido (figura 5).

 

 
 En la ventana Preferencias de sonido pulse 

sobre la pestaña Salida y seleccione Ensemble 
(figura 6).

 

figura 5

figura 6

4. Reproducción de iTunes
 Abra la aplicación iTunes, seleccione un archivo 

de audio e inicie la reproducción (figura 7).

 Pulse el botón rotatorio OUTPUT hasta que el 
LED  1 se ilumine, y ajuste el nivel de sus 
auriculares (figura 8).

 

figura 7

figura 8

Guía de inicio rápido
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Guía de inicio rápido

5.  Configuración DAW
 Configure su aplicación de audio compatible con 

Core Audio para establecer la comunicación con 
la interfaz E/S Ensemble. 

 Por ejemplo, en Logic 8 Pro :

 Seleccione Preferencias > Audio y pulse 
sobre la pestaña Dispositivos. En la ventana 
Dispositivos, pulse sobre la pestaña Core 
Audio (figura 9).

 

 Seleccione la casilla Habilitado; en el campo 
Dispositivo seleccione Ensemble y compruebe 
que la casilla Grabación 24 Bits está 
seleccionada. Pulse sobre Aplicar los cambios 
cuando haya finalizado (figura 10).

 

 Para “personalizar” las etiquetas del routing E/S 
de Logic para que se correspondan con las E/S 
de Ensemble, seleccione Opciones > Audio > 
Etiquetas E/S. Pulse sobre el círculo adyacente 
a cada etiqueta en la columna Suministrado 
por el controlador (figura 11).

 Para controlar Ensemble directamente desde 
una sesión de Logic, seleccione Opciones > 
Audio > Abrir Apogee Control Panel 

 (figura 12).

 Si está usando otra aplicación de audio 
compatible con Core Audio, use el software 
Maestro de Apogee (se instaló en la carpeta 
Applications durante la Fase 1) para controlar 
Ensemble.

 

figura 9

figura 10

figura 11

figura 12
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6. Grabación  
 Conecte un micrófono en la entrada MIC 1 del 

panel posterior (figura 13) 

 
 
 o un instrumento en la entrada HI–Z 1 del panel 

frontal (figura 14).

 

 En Logic, configure la entrada de una pista en 
Analog 1 y la salida en Analog 1/2, y active la 
pista para la grabación (figura 15). 

 Pulse el botón INPUT del panel frontal hasta que 
el LED Pre 1 se ilumine y gire el botón hasta 
obtener un nivel de grabación adecuado en la 
pista activada para la grabación (figura 16).

  
      Y ahora ya puede empezar a grabar...

figura 13

figura 15

Guía de inicio rápido

figura 16

figura 14
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Ajustes con los paneles de control del software

Todos los ajustes de Ensemble se efectúan en el panel Settings del software Maestro de Apogee o en el Panel 
de control de Apogee, en Logic Pro. Algunos de los ajustes también pueden realizarse en los paneles de control 
de audio de OS X. Es posible abrir varios paneles de control al mismo tiempo, ya que los ajustes realizados en un 
panel de control se reflejarán automáticamente en el resto. Además, es posible controlar el nivel de la ganancia 
del preamplificador de micrófono y de la salida con los botones del panel frontal de la unidad, tal y como se 
describe en la mitad inferior de esta página. 
 
¿Qué es Maestro? - Apogee Maestro proporciona el control más completo de Ensemble, incluyendo el control de 
todos los parámetros de la interfaz; el almacenamiento/recuperación de ajustes; routing ampliado y 2 mezcladores 
de baja latencia. Maestro puede ser utilizado con cualquier aplicación de audio compatible con Core Audio.
La descripción detallada del panel Settings de Maestro empieza en la pág. 14

El Apogee Control Panel de Logic Pro se encuentra dentro del menú Audio; este panel controla todos los 
parámetros de Ensemble y el almacenamiento/recuperación de ajustes.

Audio Midi Setup (AMS) – Esta utilidad de OS X (ubicada en la carpeta raíz/Aplicaciones/Utilidades) controla la 
frecuencia de muestreo, el nivel de salida y la fuente de reloj de Ensemble. 

Para ajustar el nivel de salida de Ensemble usando el deslizador de audio de la barra de menú del Mac, 
seleccione Ensemble dentro de Default Output (en AMS); los deslizadores de audio de OSX (incluyendo el 
deslizador de la barra de menú) pasarán a controlar la salida seleccionada en el panel frontal de Ensemble. Por 
ejemplo, si el LED  1 del panel frontal está iluminado, los deslizadores de audio de OSX controlarán el nivel de 
salida  1.

Ajustes con los botones del panel frontal de Ensemble

Los botones del panel frontal de Ensemble proporcionan un acceso sencillo e inmediato a los ajustes de ganancia 
del preamplificador de micrófono y los niveles de salida. 

Uso del botón izquierdo para controlar la ganancia del preamplificador de micrófono:

 Para seleccionar la ganancia del preamplificador de micrófono, pulse el botón izquierdo hasta que el 
 LED PRE deseado se ilumine.
 Gire el botón en el sentido de las agujas del reloj para aumentar la ganancia, o en el sentido contrario 
 para reducirla.
 Los LED que circundan el botón de codificación indican su “posición”, proporcionando una referencia visual 
 inmediata del nivel similar a la ofrecida por un botón tradicional.

Uso del botón derecho para controlar los niveles de salida:

 Para seleccionar el nivel de salida, pulse el botón izquierdo hasta que el LED deseado se ilumine y gire 
 el botón  tal y como se ha descrito previamente; si selecciona MAIN, se ajustarán los niveles de 
 salida analógica del panel posterior; si selecciona  1 o  2, se ajustará el nivel de salida de auriculares 
 correspondiente del panel frontal.

 Para silenciar todas las salidas analógicas, pulse y mantenga pulsado el botón derecho durante unos 
 segundos. El LED de la salida seleccionada parpadea para indicar la desactivación.

Consulte la pág. 16 para configurar la salida MAIN (principal) y la de auriculares

Funcionamiento general
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Ajuste de la frecuencia de muestreo

Para ajustar la frecuencia de muestreo de Ensemble, seleccione el valor deseado en la aplicación de 
audio compatible con Core Audio; la interfaz Ensemble se adaptará en consonancia. Si la aplicación no 
tiene asignada ninguna frecuencia de muestreo, abra la utilidad de configuración Audio/Midi de OSX, 
seleccione Ensemble dentro de Propiedades para y seleccione la frecuencia deseada en el campo 
Formato.

Uso del rango de frecuencias de muestreo 176.4–192 kHz 

Para que la unidad Ensemble opere en un rango de frecuencias de muestreo de 176.4-192 kHz, es 
necesario ajustar la opción I/O Allocation (Tools>Settings>Settings dentro de Maestro) a 10x10 u 8x8. 
Como la E/S óptica no es compatible con este rango de frecuencias, las rutas Firewire asociadas son 
desactivadas con el fin de preservar el ancho de banda de la CPU. 
Tras modificar la opción I/O Allocation, se recomienda encarecidamente reiniciar el ordenador, así como 
apagar y volver a poner en marcha la interfaz.

Ajuste de la fuente de reloj

La fuente de reloj de Ensemble se puede ajustar desde la aplicación Maestro, desde el panel de control 
de Apogee en Logic Pro o desde la utilidad Configuración Audio/Midi en OSX.

Cuando la interfaz Ensemble está sincronizada con una fuente externa, la frecuencia de muestreo de la 
unidad viene determinada por su selección en el software. Por ello, para que la frecuencia de muestreo 
de la fuente externa se corresponda con la del software, debe ajustarse manualmente. Por ejemplo, si 
desea abrir una sesión a 88.2 kHz pero sincronizar Ensemble con el word clock de un Apogee Big Ben, 
deberá ajustar manualmente el Big Ben a 88.2 kHz. 

E/S Digital

La disponibilidad de la E/S digital de Ensemble se basa en la frecuencia de muestreo de la unidad y del 
ajuste Optical I/O Format, tal y como se muestra en la siguiente tabla.

Modo autónomo

Si se interrumpe la conexión FireWire en Ensemble, la unidad entra automáticamente en modo autónomo; 
no obstante, todos los ajustes del panel de control, routing y mezclador permanecen activos a pesar de 
la ausencia del ordenador huésped. En modo autónomo, el LED de estado se vuelve verde y todos los 
controles del panel frontal permanecen activos.

Routing de Ensemble

A menos que se modifiquen las opciones de routing en la aplicación Maestro, todas las entradas 
posteriores de Ensemble se dirigirán hacia el Mac a través de Firewire, mientras que todas las salidas 
posteriores se enviarán desde el Mac a través de Firewire, tal y como se ilustra en las dos páginas 
siguientes. 

E/S 
analógica

E/S óptica E/S coaxial Total

44.1k/48k 8 8 ADAT o 2 S/PDIF 2 18
88.2k/96k 8 4 SMUX o 2 S/PDIF 2 14

176.4k/192k 8 ninguna 2 10

Funcionamiento general
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Funcionamiento general

Diagrama del routing de entrada
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18 DAW Outputs
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Funcionamiento general

Diagrama del routing de salida
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Control Maestro: Ajustes - Ajustes

Todos los ajustes de Ensemble se efectúan en el panel Settings del software Maestro de Apogee o en el Panel de 
control de Apogee, en Logic Pro. Si está usando Logic Pro, consulte la descripción del Panel de control de Apogee en el 
manual de la aplicación. 

Selección de dispositivo - En el caso de que haya varios dispositivos Apogee conectados al ordenador, esta opción 
indica cuál será la unidad controlada por Maestro.

Identificar dispositivo – Cuando está seleccionada, todos los LED del panel frontal del Ensemble “activo” se iluminan, 
permitiendo la rápida identificación del hardware que recibe los ajustes del panel de control del software.

Selección de la fuente de reloj – Este menú desplegable se utiliza para ajustar la fuente de reloj de Ensemble a 
Internal o a las entradas del panel posterior S/PDIF Coax, Optical o Word Clock

Selección del SRC – La conversión de la frecuencia de muestreo se aplica a la ruta estéreo seleccionada en el menú 
desplegable. Al convertir una entrada digital (con una frecuencia de muestreo cualquiera) a la frecuencia de muestreo de 
Ensemble (y consecuentemente a la de la sesión DAW), aplique la conversión de la frecuencia de muestreo a la entrada 
digital.

Frecuencia SRC – Al convertir la salida de la sesión DAW a otra frecuencia de muestreo, aplique la conversión de la 
frecuencia de muestreo a una salida digital (en SRC Select) y seleccione la frecuencia de muestreo de destino que 
desee en el menú desplegable Frecuencia SRC.

UV22HR – UV22HR se aplica a la ruta de audio estéreo seleccionada en esta lista desplegable. UV22HR debería 
aplicarse a las entradas analógicas y digitales en las grabaciones a 16 bits y aplicarse a las salidas digitales cuando 
las señales se envían desde Ensemble hasta dispositivos digitales (16 bits) como grabadoras DAT o de CD externas. 
UV22HR sólo está disponible a frecuencias de muestreo de 44.1k – 48k, ya que los formatos y dispositivos con valores 
superiores sólo soportan valores de 24 bits.

Asignación de las E/S – Este menú desplegable permite asignar el número de canales habilitados a través de las E/S 
Firewire. Cuando se utilizan ordenadores huésped más lentos y/o frecuencias de muestreo superiores, la asignación 
de un número inferior de canales a las E/S Firewire permite reducir el consumo de recursos del sistema durante la 
comunicación Firewire. Tenga en cuenta que si selecciona 18 x 18, la frecuencia de muestreo más alta posible es 96 kHz. 
Asimismo, es posible enviar cualquier E/S hardware a través de las E/S Firewire disponibles en las páginas de routing de 
Maestro.

Ancho de banda utilizado – Este indicador determina el porcentaje de ancho de banda usado por todos los dispositivos 
AUDIO Firewire conectados al bus Firewire interno del Mac. No se incluye el ancho de banda usado por los discos duros. 
Si el indicador lee un 100%, seleccione un ajuste I/O Allocation menor. 

Entrada óptica – Este menú desplegable permite ajustar el formato digital de la entrada óptica del panel posterior a S/PDIF o 
ADAT/SMUX.

Salida óptica – Este menú desplegable permite ajustar el formato digital de la salida óptica del panel posterior a S/PDIF 
o ADAT/SMUX.

Visor del indicador – Este menú desplegable permite ajustar la señal que aparece en los indicadores del panel frontal. 
Los ajustes disponibles son Off (los indicadores no muestran ninguna señal), Input (los indicadores muestran las 
entradas de Ensemble) o Output (los indicadores muestran las salidas de Ensemble)

Salida Word Clock – Este menú desplegable permite ajustar la frecuencia de la salida word clock para que coincida con 
la frecuencia de muestreo de la unidad (WC x 1) o con la mitad de la frecuencia de muestreo de la unidad (WC x 1/2) 
para adaptarse así a los dispositivos conectados. 
 
Modo CD – Si selecciona esta casilla, se enviará una señal estéreo de 44.1k y 16 bits a la salida S/PDIF Coax, 
independientemente de la resolución de bits o la frecuencia de muestreo de la sesión DAW. El modo CD ajusta el 
UV22HR a S/DPIF Out, y si la sesión DAW tiene asignada una frecuencia de muestreo distinta a 44.1k, ajusta SRC 
Select a S/PDIF Out y SRC Rate a 44.1k.

Mantenimiento de picos – Si selecciona esta casilla, los indicadores rojos de saturación de los indicadores del panel 
frontal y de la página Settings/Output de Maestro permanecerán iluminados en tanto no pulse el botón Clear Meters 
(Borrar indicadores) (en la ventana Mixer de Maestro).

Ajustes de entrada : Soft Limit – Si selecciona esta casilla, la protección de saturación Soft Limit de Apogee se activará 
en la entrada analógica correspondiente.

Ajustes de entrada : +4, –10, MIC – El nivel de referencia nominal de cada entrada analógica se selecciona con estos 
botones de opción. Las entradas 1–4 también puede configurarse al nivel MIC, permitiendo ajustar la ganancia entre +10 
y +75 dB.

Ajustes de salida – El nivel de referencia nominal de cada salida analógica se selecciona con estos botones de opción.
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Control Maestro: Ajustes - Ajustes (diagrama)
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Control Maestro: Niveles - Salida

Control de nivel – Los tres botones proporcionan un control de nivel para las salidas Main, HP1 y HP2. La 
atenuación de la salida de 0 a –127 dB se muestra en una lectura equivalente. 

Visor del indicador – La señal presente en cualquier canal seleccionado dentro de las listas desplegables 
Selección del formato MAIN o Selección de la fuente HP 1–2 se muestra en el indicador correspondiente.

Selección del formato MAIN – Este menú desplegable se utiliza para configurar las salidas analógicas en varias 
situaciones de monitorización. 

 Cuando Format está ajustado a Ninguna, todas las salidas analógicas funcionan como salidas de línea 
 estándar; el deslizador de nivel Main no es funcional.

 Cuando Format está ajustado a Estéreo, el deslizador de nivel Main (y el botón Output del panel frontal) 
 controla el nivel de las salidas analógicas 1–2. Las salidas 3–8 funcionan como salidas de línea estándar.

 Cuando Format está ajustado a 5.1 Surround, el deslizador de nivel Main (y el botón Output del panel 
 frontal) controla el nivel de las salidas analógicas 1–6. Las salidas 7–8 funcionan como salidas de línea   
 estándar.

 Cuando Format está ajustado a 7.1 Surround, el deslizador de nivel Main (y el botón Output del 
 panel frontal) controla el el nivel de todas las salidas analógicas.

Selección de la fuente HP1 HP2 – Estas listas desplegables se utilizan para seleccionar la fuente de señal estéreo 
en las salidas de auriculares del panel frontal.

1

2

3

4

Control Maestro: Niveles - Entrada

Pre1 – Pre4 – Los siguientes controles están disponibles para Pre1–Pre4

Control de ganancia – Este botón regula el nivel de la ganancia del preamplificador de micrófono. El rango 
de valores oscila entre +10 y +75 dB y se refleja en la lectura de salida correspondiente. 

Visor del indicador – Este indicador muestra el nivel de conversión del canal correspondiente, ofreciendo 
una referencia práctica para el ajuste de la ganancia del preamplificador de micro.

Grupos – Los controles de ganancia de dos o más presets pueden vincularse seleccionando el mismo 
grupo en esta lista desplegable. El rango de ganancia presente en la agrupación inicial se mantiene 
después de la agrupación.

Fase – Al seleccionar esta casilla, se invierte la polaridad de la entrada analógica correspondiente.

48V – Al seleccionar esta casilla, se aplica una alimentación phantom de 48 voltios a la entrada XLR 
correspondiente.

SoftLimit – Al seleccionar esta casilla, la protección de sobrecarga de Soft Limit se aplica a la entrada 
analógica correspondiente.

1

2

3

4

5

6
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Control Maestro: Niveles - Salida (diagrama)

Control Maestro: Niveles - Entrada (diagrama)
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Preferencias de Maestro
Las preferencias siguientes de Maestro determinan el comportamiento del hardware conectado. Consulte el manual 
del usuario de Maestro para más información al respecto.
 
Inicio automático de Maestro tras la conexión de un dispositivo
Si selecciona esta casilla, Maestro se iniciará automáticamente tras detectar la unidad Ensemble en el bus FireWire 
del Mac.

Habilitar los menús desplegables
Si selecciona esta casilla, al manipular los botones del panel frontal podrá visualizar los menús desplegables de los 
controles en el escritorio del Mac. Estos menús muestran varios ajustes de Ensemble, como la selección de entradas 
y salidas, los niveles, los grupos de entradas y la desactivación de las salidas. Los siguientes ejemplos lo explican 
con detalle.

Entrada Pre1 seleccionada

control ajustado a 38 dB

Entradas Pre3-Pre4 agrupadas y 

seleccionadas

control 3 ajustado a 40 dB

control 4 ajustado a 50 dB
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Preferencias de Maestro

Salida Analog (Main) seleccionada

control ajustado a 60 dB

Salida HP2 seleccionada

control ajustado a 0 dB



Panel frontal

1.  Interruptor de alimentación – Pulse este botón para poner en marcha la unidad Ensemble. Cuando 
haya conectado la entrada CA de Ensemble, el interruptor se iluminará ligeramente para indicar que la 
unidad está en Standby.

2.  LED STATUS – Este LED multicolor proporciona una rápida indicación visual del estado de varios 
parámetros.

•  El LED azul indica que Ensemble está sincronizada con la fuente de reloj seleccionada en el 
software de control y que la conexión Firewire es válida.

• El LED parpadeante indica que Ensemble no está sincronizada con la fuente de reloj 
seleccionada.

•  El LED de estado rojo indica que Ensemble no ha establecido una conexión FireWire válida. 
Transcurridos unos segundos, Ensemble se conmutará al modo autónomo.

• El LED verde indica que no hay conexión Firewire, y que Ensemble está operando en modo 
autónomo.

•  El LED parpadeante rojo indica que las dos condiciones de error están presentes.

3.  Entrada HI–Z 1–2 – Estas conexiones de 1/4" aceptan fuentes de alta impedancia como teclados y 
guitarras. Cuando se inserta un jack en el conector Hi–Z, el conector XLR de entrada es desactivado.

4.  INPUT Botón de codificación – Cuando las entradas 1–4 son ajustadas a Mic mediante el software de 
control, este botón controla la ganancia del preamplificador de micrófono. Para seleccionar la entrada 
a controlar, pulse el botón de codificación hasta que el LED PRE deseado se ilumine; gire el botón en 
el sentido de las agujas del reloj para aumentar el nivel, y en el sentido contrario para reducirlo. Los 
LED que circundan el botón de codificación indican su “posición”, proporcionando una referencia visual 
inmediata del nivel similar a la ofrecida por un botón tradicional. Si no hay ninguna entrada ajustada a 
Mic en el software de control, el botón permanecerá inactivo.

5.  LED PRE – Estos LED indican el canal seleccionado junto con el botón de selección INPUT.

6.  LED 48V – Estos LED indican que la alimentación phantom de 48 V ha sido activada en el software de 
control.

7.  Indicadores 1–8 – Estos indicadores muestran las entradas analógicas o las salidas analógicas, 
dependiendo de la configuración en el software de control.

8.  Medidores D1,D2 – El medidor D1 muestra la presencia de señal en cualquiera de los canales de E/S 
S/PDIF Coax; el medidor D2 muestra la presencia de señal en cualquiera de los canales de E/S óptica. 

9.  LED INPUT, OUTPUT – Estos LED indican si los medidores muestran las señales de entrada o salida, 
según la configuración en el software de control.

10.  LED MAIN, auriculares 1,2 – Estos LED indican la salida seleccionada para ser modificada con el 
botón de codificación OUTPUT.

11. Botón de codificación OUTPUT – Este botón controla el nivel de la salida seleccionada tal y como 
lo indican los LED MAIN, hp1 y hp2. El funcionamiento es similar al del botón de codificación Input 
descrito previamente. Si Main está ajustado a None (ninguno) en el software de control, el botón de 
codificación no tendrá efecto sobre las salidas principales (Main).

12  1,2 – Estos conectores TRS proporcionan las salidas para auriculares
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1.  MIC1–4 – Estos conectores XLR aceptan entradas de línea o micrófono balanceadas; el nivel 
de entrada lo determina el software de control.

2.  INSERT SEND – RETURN (canales 1–2) – Estos conectores TRS proporcionan los puntos de 
inserción analógicos balanceados antes de la etapa de conversión A/D; al conectar un jack en 
la toma RETURN, se activa el retorno de la inserción. 

• El envío de la inserción también puede servir como salida directa: cuando sólo 
se conecta el envío de la inserción, la señal de la etapa de conversión A/D no se 
interrumpe.

• El retorno de la inserción también sirve como entrada de línea TRS balanceada.

3.  HI–Z (canales 3–4) – Estos conectores TRS aceptan entradas de alta impedancia para los 
canales 3–4, similar a las entradas HI–Z del panel frontal.

4.  ANALOG INPUT 5–8 – Estos conectores TRS aceptan entradas de nivel de línea para los 
canales 5–8; el nivel de entrada lo determina el software de control.

5.  ANALOG OUTPUT 1–8 – Estos conectores TRS aceptan salidas de nivel de línea para los 
canales 1–8; el nivel de entrada lo determina el software de control.

6.  S/PDIF – Estos conectores coaxiales proporcionan E/S digitales en formato S/PDIF.

7.  OPTICAL IN/OUT – Estos conectores Toslink proporcionan E/S digitales en formato S/PDIF, 
ADAT o SMUX; el formato se determina en el software de control.

8.  FIREWIRE – Estos conectores FW 400 proporcionan E/S Firewire en un ordenador 
 Apple OSX.

Modo autónomo – Si Ensemble no detecta una conexión Firewire válida, conmutará 
a modo autónomo transcurridos unos segundos. Esto viene indicado por un LED 
STATUS rojo (conexión Firewire presente pero no válida) o por un LED verde (cuando 
no hay conexión Firewire). En modo autónomo, todos los ajustes de routing, mezcla 
y control realizados en la unidad durante la última conexión al Mac son almacenados 
en la memoria flash de Ensemble, haciendo posible el uso de la unidad cuando no 
está conectada al ordenador. Por ello, es posible usar Ensemble como un mezclador 
autónomo o un conversor AD-DA.

9.  WORD CLOCK IN/OUT – Estos conectores BNC proporcionan las E/S de word clock.

10.  WC IN 75 OHM TERM – Este conmutador corta la entrada de word clock con una carga de 
 75 ohm.

11.  AC IN – Este conector IEC acepta una entrada CA de 90–250 voltios.
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Conexiones del estudio

2 Instrumentos 2 Auriculares

DVD/CD

Monitores 
activos

Sintetizador

Micrófonos

Configuración básica de estudio:
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Conexiones del estudio

Configuración surround 5.1:

5.1 Surround 
Configuración de los 

altavoces
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Configuración de las aplicaciones de audio

Soundtrack Pro de Apple

Para seleccionar Ensemble como dispositivo de E/S:

1.  Reproducción – abra la utilidad Configuración 
Audio/Midi (AMS) en OSX que encontrará dentro 
de la carpeta Aplicaciones > Utilidades y ajuste 
Salida por defecto a Ensemble. (figura 24)

 
2.  Grabación – en Soundtrack Pro, abra Ventana > 

Reproducción y ajuste Entrada y Dispositivo de 
monitorización a Ensemble. (figura 25)

Para controlar los ajustes de Ensemble:

1. En Apogee Maestro, abra Window > Settings.

Apple FInal Cut Pro

Para seleccionar Ensemble como dispositivo de E/S:

1.  Reproducción – Abra Final Cut Pro > Audio 
Video Settings y ajuste Audio Playback a 
Ensemble. (figura 26)

2.  Grabación – Abra Tools > Voiceover y ajuste 
Source a Ensemble. (figura 27)

Para controlar los ajustes de Ensemble:

1. En Apogee Maestro, abra Window > Settings.

Configuración de Ensemble para su uso con las aplicaciones de audio

Configuración de Ensemble para su uso con aplicaciones Core Audio:
  1) Seleccione Ensemble en el menú de controladores del dispositivo;
  2) Abra el panel de control del software para controlar los ajustes de Ensemble.

figura 24

figura 25

figura 26

figura 27
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Configuración de las aplicaciones de audio

figura 28

figura 29

figura 30

MOTU Digital Performer

Para seleccionar Ensemble como dispositivo 
de E/S:

1. En Digital Performer, abra Setup > Configure Audio 
System > Configure Hardware Driver. (figura 28)

2. Ajuste Master Device a Ensemble (figura 29)
3. Ajuste Work Priority a Low (figura 29)

Para controlar los ajustes de Ensemble:

1.  En Apogee Maestro, abra Window > Settings.

 

Steinberg Nuendo
Para seleccionar Ensemble como dispositivo 
de E/S:

1. En Nuendo, abra Devices > Device Setup y seleccione 
VST Audiobay en la columna Devices. (figura 30)

2. Ajuste Master ASIO Driver a Ensemble. (figura 31)
3. Cuando aparezca la pregunta “Do you want to select 

another MASTER ASIO driver?”, pulse “Switch”.

Para controlar los ajustes de Ensemble:

1.  En Apogee Maestro, abra Window > Settings.

figura 31
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Resolución de problemas

El LED de alimentación está iluminado, pero los demás no lo están; ¿está la unidad en 
funcionamiento?

– Todavía no; cuando Ensemble está conectada a la toma de corriente, el indicador de 
alimentación se ilumina ligeramente para indicar que la unidad está en Standby. Pulse el 
interruptor de alimentación para poner en marcha la unidad.

¿Cómo puedo verificar rápidamente si el sistema Ensemble funciona correctamente?

– Compruebe que el LED STATUS de Ensemble es de color azul (verifica el reloj de 
Ensemble);
– Compruebe que la unidad aparece en el AMS por número de serie (verifica la conexión 
de audio Firewire);
– abra Maestro (o el Panel de control de Apogee, en Logic Pro), pulse sobre “Identificar 
dispositivo” y compruebe que todos los LED se iluminan (verifica la conexión Firewire del 
software de control).

Ensemble no aparece ni en la aplicación de audio ni en la configuración Audio/Midi.

– Compruebe que tiene instalada la versión requerida de OS X
– ¿Es el LED STATUS de Ensemble de color azul? De no ser así, vuelva a conectar el 
cable Firewire o reemplácelo por otro.

No puedo controlar Ensemble ni desde el Panel de control de Apogee (Logic Pro)  
ni desde Maestro.

– Compruebe la presencia de este archivo: System > Library > Extensions > 
apogfwplugin.bundle. Si no lo encuentra, vuelva a instalar el software desde el CD 
suministrado con Ensemble.

No aparece ninguna señal en las salidas analógicas 1–2.

– Abra Maestro, ajuste Meter Display a Output, y compruebe si hay señal en los 
indicadores. De no haber señal, compruebe el routing de la aplicación de audio. Si la 
señal aparece en los indicadores pero no está presente en las salidas analógicas 1–2, 
compruebe que el nivel de salida MAIN está activado (bien en Maestro o mediante el 
botón OUTPUT del panel frontal).

El botón OUTPUT del panel frontal no atenúa la señal de las salidas analógicas 1–2.

– Cuando Format Select está ajustado a None (en Maestro), el botón OUTPUT del 
panel frontal no atenúa el nivel de salida. Ajuste Format Select a Stereo.

Los indicadores no funcionan en absoluto.

– Compruebe que el ajuste METER en el Panel de control de Apogee (Logic) no está 
ajustado a OFF.
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Deseo ejecutar Ensemble a 176.4 –192 kHz, pero sólo veo 44.1–96 kHz en AMS.

– Ensemble puede operar con frecuencias de muestreo de 44.1-96 kHz o 176.4-192 kHz, 
dependiendo del ajuste Sample Rate Range definido en el panel Settings de Maestro (Apogee). 
Para modificar el rango de frecuencias de muestreo, abra Maestro>Window>Settings y ajuste 
Sample Rate Range al valor deseado. A continuación, cierre todas las aplicaciones de audio y 
espere 30 segundos para que Ensemble pueda reiniciarse con el nuevo rango de frecuencias.

Estoy intentando sincronizar Ensemble a una fuente externa, pero el LED STATUS no deja 
de parpadear.

– Cuando la interfaz Ensemble está sincronizada con una fuente externa, la frecuencia de 
muestreo de la unidad viene determinada por su selección en el software. Por ello, para que la 
frecuencia de muestreo de la fuente externa se corresponda con la del software, debe ajustarse 
manualmente. Es decir, si desea abrir una sesión a 88.2 kHz pero sincronizar Ensemble con el 
word clock de un Apogee Big Ben, deberá ajustar manualmente el Big Ben a 88.2 kHz. 

¿Cómo puedo restaurar Ensemble a sus valores predeterminados?

– Para restaurar los valores predeterminados de Ensemble, pulse el botón izquierdo del panel 
frontal y ponga en marcha la unidad, y siga pulsando el botón hasta que la unidad haya finalizado 
su proceso de inicio.
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Avisos y Copyright

Aviso FCC
Este dispositivo es conforme con los límites establecidos por la Clase A para aparatos digitales, según lo estipulado 
en la Parte 15 de las normas FCC. Estos límites han sido establecidos para ofrecer una protección razonable 
contra interferencias no deseables en entornos comerciales. Esta unidad genera, usa y puede transmitir señales 
de radiofrecuencia y, si no se instala y utiliza de conformidad con las instrucciones de este manual, puede provocar 
interferencias no deseables en las radiocomunicaciones. El uso de este equipo en una zona residencial puede provocar 
interferencias perjudiciales, en cuyo caso el usuario deberá adoptar por su cuenta las medidas necesarias para evitar 
esas interferencias.

Aviso de copyright
Apogee Ensemble es un dispositivo basado en ordenador y contiene y utiliza software en ROMs. Este software y toda su 
documentación asociada, incluyendo este Manual del usuario, contiene información propiedad de Apogee protegida por 
leyes de copyright. Reservados todos los derechos. No es posible copiar, transferir o modificar ninguna parte del software 
o de su documentación asociada. No es posible modificar, adaptar, traducir, ceder, distribuir, vender o crear obras 
derivadas del software o de su documentación asociada (o de cualquiera de sus partes) sin el consentimiento escrito de 
Apogee Electronics Corporation, U.S.A.

Aviso relativo al software
La redistribución y utilización en forma binaria o de código fuente, con o sin modificación, están permitidas en el caso de 
que se cumplan las siguientes condiciones:

• Las redistribuciones de código fuente deben incluir el aviso de copyright anteriormente expuesto, esta lista de 
condiciones y la notificación de exención de responsabilidad especificada más abajo.

•  Las redistribuciones en forma binaria deben reproducir el aviso de copyright anteriormente expuesto, esta lista 
de condiciones y la notificación de exención de responsabilidad especificada más abajo en la documentación y/o 
demás materiales proporcionados con la distribución.

ESTE SOFTWARE HA SIDO PROPORCIONADO POR LOS PROPIETARIOS Y CONTRIBUYENTES DEL 
COPYRIGHT "EN EL ESTADO ACTUAL", Y CUALQUIER GARANTÍA EXPRESA O IMPLÍCITA, INCLUYENDO 
(PERO NO CON LIMITACIÓN A) LAS GARANTÍAS IMPLÍCITAS DE COMERCIALIZACIÓN Y ADAPTACIÓN A UN 
PROPÓSITO PARTICULAR, QUEDA EXENTA DE RESPONSABILIDAD. EN NINGÚN CASO LOS PROPIETARIOS 
O CONTRIBUYENTES DEL COPYRIGHT SERÁN RESPONSABLES DE NINGÚN DAÑO DIRECTO, INDIRECTO, 
INCIDENTAL, ESPECIAL, EJEMPLAR O DERIVADO (INCLUYENDO, PERO NO CON LIMITACIÓN A, LA OBTENCIÓN 
DE BIENES DE SUSTITUCIÓN O SERVICIOS, LA PÉRDIDA DE OPERATIVIDAD, DATOS O RENDIMIENTO 
O LA INTERRUPCIÓN DE UNA ACTIVIDAD) QUE HAYA SIDO CAUSADO BAJO CUALQUIER PRINCIPIO DE 
RESPONSABILIDAD, YA SEA EXPRESADA EN UN CONTRATO, RESPONSABILIDAD ESTRICTA O POR AGRAVIO 
(INCLUYENDO O NO NEGLIGENCIA), Y RESULTANTE DE CUALQUIER FORMA DE USO DE ESTE SOFTWARE, 
INCLUSO SI LA POSIBILIDAD DE TAL DAÑO HA SIDO ADVERTIDA.
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Declaración de conformidad—FCC

Apogee Ensemble
Este dispositivo es conforme a lo estipulado en la Parte 15 de las normas FCC. El funcionamiento está sujeto a las 
siguientes condiciones: 
(1) Este dispositivo no puede causar interferencias perjudiciales
(2) Este dispositivo debe aceptar cualquier interferencia recibida, incluyendo las interferencias que puedan provocar un 
funcionamiento indeseado.
Este dispositivo es conforme con los límites establecidos por la Clase B para aparatos digitales, según lo estipulado 
en la Parte 15 de las normas FCC. Estos límites han sido establecidos para ofrecer una protección razonable contra 
interferencias no deseables en instalaciones domésticas. Esta unidad genera, usa y puede transmitir señales de 
radiofrecuencia y, si no se instala y utiliza de conformidad con las instrucciones de este manual, puede provocar 
interferencias no deseables en las radiocomunicaciones. Si la unidad provoca interferencias en la recepción de radio 
o televisión, lo cual podrá comprobar conectando y desconectando la unidad, intente reducir la interferencia aplicando 
alguna de las medias siguientes:
1. Reoriente o cambie la ubicación de la antena receptora.
2. Aumente la separación entre la unidad y el receptor.
3. Conecte la unidad y el receptor en tomas eléctricas diferentes, de modo que ambos utilicen circuitos eléctricos 
distintos.
4. Consulte con su proveedor o técnico especializado en radio/TV.
NOTA: El uso de un cable no protegido con este equipo está prohibido.
ATENCIÓN: Los cambios o modificaciones no aprobados de forma expresa por el fabricante responsable del 
cumplimiento de las condiciones de uso pueden anular la autoridad del usuario para utilizar el equipo.

Apogee Electronics Corporation, 1715 Berkeley St, Santa Monica, CA 90404. 
Betty Bennett, CEO.

Industry Canada Notice

This Class B digital apparatus meets all requirements of the Canadian Interference–Causing Equipment Regulations. 
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matérial brouilleur du Canada.

Declaración de conformidad – CE

Apogee Electronics Corporation declara por la presente que el producto Ensemble, al que se refiere esta declaración, 
cumple las condiciones materiales especificadas por los siguientes estándares o documentos normativos:
• EN50081–1/EN55022; 1995
• EN50082–1/IEC 801–2, 3, 4; 1992
según las disposiciones de:
• 73/23/EEC – Directiva de bajo voltaje
• 89/336/EEC– Directiva EMC

Declaración de conformidad – Japón

Apogee Electronics Corporation declara por la presente que el producto Ensemble, al que se refiere esta declaración, 
cumple las condiciones materiales del estándar VCCI Clase A.

Declaración de conformidad – Australia

Apogee Electronics Corporation declara por la presente que el producto Ensemble cumple las condiciones materiales del 
estándar AN/NZS.

Declaraciones de conformidad
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Asegúrese de registrar su unidad Ensemble rellenando la tarjeta de registro incluida o completando el formulario de 
registro on-line publicado en nuestra página web: http://www.apogeedigital.com/support/. Una vez efectuado el registro, 
Apogee podrá contactar con usted a través de la dirección especificada en el registro para ofrecerle todo tipo de 
información acerca de ampliaciones o actualizaciones. Las actualizaciones de firmware son gratuitas durante el primer 
año de propiedad del producto a menos que se especifique lo contrario. Por favor, si tiene alguna duda póngase en 
contacto con su distribuidor o directamente con Apogee:

APOGEE ELECTRONICS CORPORATION, 
1715 Berkeley St, Santa Monica, CA 90404, USA. 
TEL: (310) 584–9394, FAX: (310) 584–9385
E-mail: support@apogeedigital.com. Página web: http://www.apogeedigital.com/

APOGEE ELECTRONICS CORPORATION garantiza este producto ante defectos materiales y de fabricación en 
condiciones normales de uso durante un periodo de 12 meses. El plazo de esta garantía empieza el día de la venta al 
comprador. devueltas para reparación a Apogee o a un proveedor de servicios autorizado por Apogee serán reparadas o 
reemplazadas a discreción del fabricante sin coste para el usuario. 
TODOS LOS ENVÍOS DE UNIDADES DEVUELTAS A APOGEE O A UN PROVEEDOR DE SERVICIOS DE 
REPARACIÓN AUTORIZADO POR APOGEE DEBEN SER PREVIAMENTE PAGADOS, ASEGURADOS Y 
ADECUADAMENTE EMPAQUETADOS, PREFERIBLEMENTE, EN SU CAJA ORIGINAL. Apogee se reserva el derecho 
a modificar o mejorar el diseño en cualquier momento y sin notificación previa. Los cambios de diseño no se implementan 
de forma retroactiva, y la incorporación de cambios de diseño en unidades futuras no implica la disponibilidad de 
actualizaciones para las unidades existentes.

Esta garantía queda anulada si Apogee determina, a su entera discreción, que el defecto del producto es resultado de 
mal uso, negligencia, alteración o una reparación realizada por personal no autorizado. 

Las garantías especificadas en este documento sustituyen a cualquier otra garantía expresa o implícita, y Apogee 
queda específicamente libre de responsabilidad ante cualquier garantía implícita de comercialización o adaptación a un 
propósito particular. El comprador comprende y acepta que Apogee en ningún caso será responsable de ningún daño 
especial, indirecto, incidental o derivado, ni de cualquier lesión o daño sufrido por una persona o propiedad que pueda ser 
resultado de un funcionamiento incorrecto de este equipo en cualquier momento. 

EEUU: Algunos estados prohíben la exclusión o limitación de garantías implícitas o de la responsabilidad ante daños 
incidentales o derivados, de manera que la exclusión especificada más arriba puede no ser aplicable al usuario. Esta 
garantía le otorga derechos legales específicos, y es posible que disponga de otros derechos que pueden variar entre 
estados. 

Información de servicio

Ensemble contiene componentes no manipulables por el usuario: acuda a personal cualificado para llevar a cabo las 
reparaciones o actualizaciones. La garantía quedará anulada si el usuario manipula los componentes internos. Si tiene 
alguna duda respecto a esta consideración, por favor póngase en contacto con Apogee. 

En el caso de que su unidad Ensemble deba ser actualizada o reparada, póngase en contacto con Apogee antes de 
enviar la unidad para que le sea asignado un número de autorización de devolución de material (Return Materials 
Authorization - RMA). Este número le servirá de referencia y facilitará el proceso de devolución. Apogee exige que los 
envíos sean asegurados y pagados previamente a menos que se indique lo contrario por adelantado. 

IMPORTANTE: NO SE ACEPTARÁ NINGÚN ENVÍO QUE NO HAYA SIDO PAGADO PREVIAMENTE O QUE NO 
TENGA UN NÚMERO RMA ASIGNADO. 

Registro e información de garantía
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